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Moi… demain
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Agenda

� Evènements
� RFEs
� Evolutions de nos produits 

favoris… IMPACT
� Injecteurs MQ : JMSHarness
� SMFez-vous ?
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WebSphere Tech Convention, 15-18 oct, Berlin

http://www.ibm.com/jct03001c/services/learning/ites.wss/zz/en?pageType=page&c=O757056Y17644M69
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TechSoftware, IBM BoisColombes, 29-31 août

http://www.ibm.com/software/fr/techsoftware-2012/index.html
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RFEs

� Préparez votre demande avec nous pour la raffiner
– Faites impliquer qqn qui écrit bien anglais dans la préparation….. 

– N’oubliez pas de lui offrir un verre….

� C’est la saison pour voter : signaler à notre communauté quand la RFE 
est saisie afin qu’un maximum parmi nous le soutient (Voter Yes!)
– Profitez d’un Président GSF MQ très proactif….

� Ne soyez pas trop déçu si la demande n’aboutit pas… le labo ne peut 
pas tout faire.  Ils doivent constamment équilibrer…
– Intérêt parmi les utilisateurs (votes)

– Intérêt “architecturel” (stratégie, direction du produit long-terme)

– Complexité (coût) pour la modification

– Besoins tactiques (pour influencer des ventes courtes-termes)

– …. 
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MQ v7.5 from Impact
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WMQ Family Roadmap – continual delivery of customer 
value 

(3Q/09)
MQ V7.0.1 with
Multi-Instance QMgrs,
Automatic Client Reconnect,
z/OS Availability, Capacity 
and Performance 
improvements

(4Q/09)
MQ FTE V7.0.2 
FTP Bridging

(4Q/10)
MQ FTE V7.0.3 
end-to-end security
HTTP gateway
Msg <-> File 

(2Q/11)
MQ FTE V7.0.4 
C:D Integration

Early Access Programs

2009 2010 2011 2012

(4Q/11)
MQ V7.1 with 
Multi-version Install,
Out-of-the-box 
security,
Multicast capability,
Improved 
Performance, 
z/OS Shared Q 
enhancements

(05/08)
MQ V7 with
Integrated Pub/Sub
Rearchitected JMS
Extended APIs

(12/08)
MQ FTE V7.0 

(07/10)
Message Broker 
V7.0.0.1
User-Defined Patterns
FTE Nodes

(12/11)
Message Broker V8.0
DFDL msg definition
Record, Replay msg
.Net enhanced

•8

(2Q/12)
MQ V7.5 with 
Packaging update 
(FTE, AMS, MQTT),
Split cluster XMITQ

(4Q/10)
MQ Advanced Message Security 
V7.0.1
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WebSphere MQ V7.5: Content Summary

For Windows, Unix and Linux

•CSS: F  S

WebSphere MQ V7.5

Announced: 24 April 2012

Availability: 20 June 2012

New Feature Benefits Details

Integrated Installation
Makes it easier to deploy systems

Simpler licensing

Combines several products into a single package

Common experience

Enhanced Clustering
Improves ease-of-use

Improves application isolation
Split Cluster Transmission Queue

Java Application 
Identification

Makes it easier to distinguish applications Applications no longer to all have the same name

AMS channel interception
Provides a level of message protection even 
when application environment cannot run 
AMS

Interception in the SVRCONN still protects messages before 
hitting queues

FTE Logger Options Can write FTE audit records to flat file
No longer a requirement for an enterprise database

Easier to read data immediately
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WebSphere MQ V7.5
� Integrated Messaging Offering

– Single install, packaging & tooling for all Messaging options
– Reduce time to value, simplify usage

� What’s being delivered? 
– Integration of MQ with MQ FTE, MQ AMS and MQ Telemetry
– Single install, common integrated tooling and management, 

simplified licensing and entitlements
– Updated MQ Explorer tooling for all platforms 
– More complete, easy to use messaging infrastructure, 

enabling you to gain full range of messaging, swiftly & easily

� All messaging functions & capabilities 
available to all customers, new and existing 
with rich choice of qualities of service

– Removal of charge for MQ XA client 
– Reduced pricing metric for standard MQ Telemetry client

• Lower cost for larger numbers of clients

Advanced Msg Security

AMS Documentation

WebSphere MQ

Advanced Message Security

MQ Server (Queue manager)

MQ Client

MQ Documentation

File Transfer Edition

FTE Server

FTE Client

FTE Docs + tools

WebSphere MQ

MQ Server (Queue manager)

MQ Client

Multi-Language Documentation

+ MQ TT Gateway
+ Advanced Message Security
+ Managed File Transfer Service
+ MQ Explorer with built-in

AMS & managed file transfer

+ AMS Enablement
+ MQ TT Clients

Managed File Transfer Agent
+ AMS Enablement

+ Security (AMS) sections
+ Managed File Transfer sections

•CSS: F  S

Je n’ai pas parlé des prix ! 
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Clustering – Split Transmit Queue Requirements

� Separation of Message Traffic

– With a single transmission queue there is potential for pending messages for 
cluster channel 'A' to interfere with messages pending for cluster channel 'B'

� Management of messages

– Use of queue concepts such as MAXDEPTH not useful when using a single 
transmission queue for more than one channel

� Monitoring

– Tracking the number of messages processed by a cluster channel currently 
difficult

– Some information available via Channel Status

•CSS: F  S
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Clustering – Split Transmit Queue

� With V7.5 a queue manager can automatically define a PERMANENT-
DYNAMIC queue for each CLUSSDR channel.

– Dynamic queues based upon new model queue 
“SYSTEM.CLUSTER.TRANSMIT.MODEL”

– Well known queue names: “SYSTEM.CLUSTER.TRANSMIT.<CHANNEL-
NAME>”

� Controlled via attribute affecting all cluster-sdr channels on the queue manager

� Also have manual definitions

– Multiple queues can be defined to cover all, or a subset of the cluster channels.

� Automatic and Manual are not mutually exclusive

– They could be used together

ALTER QMGR DEFCLXQ( SCTQ | CHANNEL )

DEFINE QLOCAL(APPQMGR.CLUSTER1.XMITQ)

CHLNAME(CLUSTER1.TO.APPQMGR) USAGE(XMITQ) 

V7.5

•CSS: F  S
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Java Application Identification

� Java client applications now fill in APPLTAG field

� No longer appear as “WebSphere MQ Client for Java”

� Application-provided property

� Or the Main class 

V7.5

CSS: F  S

V7 
Explorer

V7.5 Explorer
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MQ 7.5: Enhancements to newly-integrated components

� Managed File Transfer

– Logger can now write to a file

� AMS

– V7.0.1.2 enhancements
• Supports SHA-2 Digest algorithms

• Command and Configuration Events for Policy changes

• Audit trail of who has changed configuration

– SVRCONN interception

V7.5

CSS: F  S



Software Group

© 2012 IBM Corporation p15

MQ Performance testing

� Send a message, measure the time (elapsed, CPU…)
– Conceptually simple, but how do you do it? And when you look at the details… not 

that simple at all!
– Measure under max load?  Fill the queue?  Multi-thread? Measure Q/R? etc…

� Typically: use a “message injector”
– AMQSBLST (“sample” delivered with several MQ Distributed platforms)
– JMSHarness (or XMSHarness)
– MA0T MsgText
– IH03 “MQSI” msg utility (RFHUTIL, MQCAPONE, MQPUTS….)
– MA01 Q
– Loadrunner
– Others?  See http://www.capitalware.biz/mq_tools_comm.html#mqdebug or 

http://www-304.ibm.com/support/docview.wss?rs=977&uid=swg27007205
� Some include reports, some suppose that you have other complementary 

tools for reporting

MQ PUT
Request 

application

QM
MQ GET 
Request 

application

MQ PUT
Reply 

application

QM
MQ GET 

Reply 
application

TIME
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JMSHarness, what is it?

� “a flexible and modular Java package for performance testing of JMS scenarios and 
providers.”
� A rich tool for driving MQ (or HTTP) loads (not limited to JMS!)
� Available free of charge:

https://www.ibm.com/developerworks/community/groups/service/html/communityview?com
munityUuid=1c020fe8-4efb-4d70-afb7-0f561120c2aa

or
http://www.alphaworks.ibm.com/tech/perfharness?open&S_TACT=105AGX21&S_CMP=AWRSS
� After downloading, you get:

– Perfharness.jar

– Manual.pdf

That’s it!
� This is THE tool used by IBM Hursley labs to drive their MQ tests (referred to in the MQ 

performance reviews).  Now you, too, can be a MQ performance pro!
� An XMS Performance Harness Tool is also available, announced and supported with MQ 

v7, and for testing MQ performance with .Net.  See SupportPac IA9H or 
https://www.ibm.com/developerworks/mydeveloperworks/files/app/collection/5bd0fa23-
4704-44dc-a5d5-ffe7cd205bf3?lang=en
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JMSHarness, how do I get it going?
� Friendly advice: first do your standard setup and IVP for MQ Java on your platform, eg.

– Setup your Environment variables as per 
http://publib.boulder.ibm.com/infocenter/wmqv7/v7r0/topic/com.ibm.mq.csqzaw.doc/jm10330_.htm

– Setup PATH, CLASSPATH, MQ_JAVA_DATA_PATH, MQ_JAVA_INSTALL_PATH, 
MQ_JAVA_LIB_PATH

– Test using   IVTRun -nojndi at a minimum

– If you want to use JMS & JNDI, use IVTSetup , and test JMSAdmin and IVTRun

� Setup the JMSHarness specific environment, eg. For Windoze…. 
set CLASSPATH=perfharness.jar;%CLASSPATH%

� That’s it!
� Running JMSHarness:

E:\perfh> java JMSPerfHarness -tc mqjava.PutGet -nt 5 -d Test -jb QM_carl510
ControlThread1: START
PutGet1: START
PutGet1: Opening Test
PutGet2: START
PutGet2: Opening Test

:
PutGet5: STOP
totalIterations=455740,avgDuration=62.60,maxrateR=7 353.97
ControlThread1: STOP



Software Group

© 2012 IBM Corporation p18

JMSHarness, some of Carl’s favorite parameters

Parm Description

-tc Test Class, eg. jmsSender, PutGet, Responder, Pu blisher, etc.

-nt Number of  (parallel) Threads to run the class

-d Name of target Queue

-jb Name of Queue Manager

-mf Specify input file to be used for sending messag e

-pp Persistent messages

-tx Send messages under transaction

-nl Time to run test 

-rt Iterations rate (iterations per second). Default is “as fast as you can”.

-mg Total number of iterations

-ms Message size in bytes

etc. About 100 other parameters!  Very flexible!
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JMSHarness, example Send

E:\Junk\All\perfharness_v120\perfharness>java JMSPe rfHarness -tc mqjava.Sender
-d Test -jb QM_carl510 -rl 20 -sr 10 -ss 5  -ms 200 0 -rt 1
ControlThread1: START
Sender1: START
rateR=1.00,threads=1
rateR=1.00,threads=1
rateR=1.00,threads=1
rateR=1.00,threads=1
Sender1: STOP
totalIterations=21,avgDuration=21.17,maxrateR=1.00
ControlThread1: STOP

•Send 1 msg/sec (-rt) of 2000 bytes (-ms) during 20 seconds (-rl) with reports every 5 seconds (-ss) and 
sampling ever 10 seconds (-sr)
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JMSHarness, example Request/Reply
•Using 5 threads (-nt), send as many persistent (-pp) requests as possible to MyRequest queue, and get replies 
back on MyReply queue, for 20 seconds (-rl)

E:\perfharness>java JMSPerfHarness -tc mqjava.Requestor -iq MyRequest -oq MyReply -jb 
QM_carl510 -rl 20 -sr 10 -ss 5  -ms 2000 -nt 5 -pp
ControlThread1: START
Requestor1: START
Requestor2: START
Requestor5: STOP
Requestor2: STOP
totalIterations=5155,avgDuration=22.61,maxrateR=315.30
ControlThread1: STOP

e:\Junk\All\perfharness_v120\perfharness>java JMSPerfHarness -tc mqjava.Responder -iq 
MyRequest -oq MyReply -jb QM_carl510 -to 30 -nt 5
ControlThread1: START
Responder1: START
Responder2: START

:
rateR=43.90,threads=5
MQJE001: Completion Code '2', Reason '2033'.
Responder3: Uncaught exception. 

: (ugly Java tracebacks here for each thread!)
Responder5: STOP
totalIterations=5155,avgDuration=55.07,maxrateR=171.83
ControlThread1: STOP

•Using 5 threads (-nt), receive requests on MyRequests queue (-iq) and send them back on MyReply queue
(-oq)
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MA0T MsgTest utility (slides de Guide mai 2005)

• Outil de test pour des messages MQ

• MQPUT et/ou MQGET des messages

• Construire des entêtes (MD, RFH) dans un 
« langage » XML

• Support des boucles, variables, etc.

• Comparaisons (tests de regression)

• SupportPac MA0T depuis…
http://www.ibm.com/software/integration/
support/supportpacs/product.html#wmq

• SupportPac catagory 4 (3rd party, AS-IS) 
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MsgTest – fichier de contrôle
<MsgTest>
<Control>

<QMgr>QM_WBIMB</QMgr>
<Channel>SYSTEM.DEF.SVRCONN</Channel><Host>localhost</Host><Port>1418</Port>
<TestLog>

<File>NONE</File>
<Dir>E:\Junk\MsgTest</Dir>

</TestLog>
</Control>
<Test Name="PutIt">

<!-- GetFile><File>FileIn1.txt</File><Dir>%Dir%DataIn</Dir></GetFile -->
<InlineData>

<!-- Buffer>MyBuff</Buffer -->
<Data>Data?? </Data>

</InlineData>
<MQMD Name="MD01">

<CorrelId>REQREP1</CorrelId>  <MsgType>1</MsgType>  <Format>MQSTR</Format>
<ReplyToQ>TestOut</ReplyToQ> <Persistence>1</Persistence>

</MQMD>
<For Name="Knt" From="1" To="10" Incr="1" Format="%02d">

<Overlay Pos="5" Len="2">
<Data>%Knt%</Data>

</Overlay>
<PutMsg MQMD="MD01">

<MsgId>CountIs%Knt%</MsgId>
<Q>TestOut</Q>

</PutMsg>
</For>

</Test>
</MsgTest>

Id QMGR, 
journalisation, 

etc.

Définition des 
données du 

msg

Valeurs du 
MQMD

Boucle avec 
données 
variable

Valeur du 
MQMD 
variable

Identification 
de la file.
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Exécution du MsgTest

E:\Junk>msgtest c:\Tools\MsgTestTest.xml

**** MsgTest V1.2.1 Started.  **** Compiled on Feb 17 2005 at 06:00:12 ****

I012 Successfully loaded File="c:\Tools\MsgTestTest.xml". Size=1629/1204 bytes.

I019 Successfully parsed ScriptFile="c:\Tools\MsgTestTest.xml".

I027 Logging suppressed TestLog.File=NONE specified.

I034 Test Num=001 Test=PutIt. Initialised.

I035 Test Num=001 Test=PutIt. Assigned to the active list.

I075 Test load phase completed. Test execution phase started..

I168 Test Num=001 TotalPutMsg=10 SuccessfulPutMsg=10 FailedPutMsg=0.

I036 Test Num=001 Test=PutIt. Completed successfully.

I093 Interval statistics.

I108     No intervals were defined

I107 I062 Test results Total=1 Successful=1 Failed=0 Incomplete=0.

**** MsgTest V1.2.1 Finished. ****
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SupportPac MP1B - MQ SMF usage analysis
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IAM9: Message Broker – ILog JRules Decision 
Management Node
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MQ 7.1 Activity reports and SupportPac MS0P


